Aqul usRMi 2D selad uA adlRyy QA wewd sl 2N viaRUM- @iy v,
sl A 21QDRUY A A u WAL Ghe WAl waizu wadl B, AR ol L sl 3
VANRHHA WHAL FdUn 2 B, WM aval W2 s euu) Gudsy 8, A wudl o
ns L B, v usRHL N Y cuw QA wRay Andy,

WuRia el ¥3R3a (Need of programming language)

sved Awen wa A owy 3 Wb eunudl o3Rud w w2 & 7 udddl wWwud ¥« wnella
¢l ddl 2@ I dprudl el Gudlal 43R WA W w2 avll A4 wsy ? oawst W B %, wi
oul alsdldl As o ] el ol 2l A payzr wd YA Ad sl s 23 Adl swer
gl AG s sudal W2 eds asy wdyel wAd YMBuA g w3l B,

WIUGHL el Gualat 531 amail sidell il Wl g o v du 8. d ydFuiRa Fusd-d
dRL 4RI 8, W [l BUMAPL M W2 asuAAl(syntax)l AL 53 B, 2w, WAGRL euw
ol ved Al Adl asuradl fludl, FA gL Skl AN AR YAUBL [FlRduRl
¥ &9 wny, 2 sl QS uel adl el dluidl aud Al ens@ ollval A B,

vijuesdl ¥3RUA (Need of translator)

suvel g sdlendedl oua 3 ufoL eusil gL SRR WM Asd Al d Wal 0 A 1] euw
Az 8. dl YAl WAl YA SIS 2L WAl 4Bl sl G Elul WAl 3 X uiA
Y 6 eyl 8, ¥ wsollandl eunl madl sl @alFi-X opridl eum ol 8 el aalsi-Y Rl
ol N B, ¥ A olfminl Idl dd Bselln W AdRd 524 ? Wi Rsey i A e
AFa-Z ¥3dl 8, ¥ U o4 cuwidl Mmesr U ¢d, XA alf-y Yl A e udiagd
¢ AR, d uad drdl erudl AlfEi-ZA dedl s4d. l5d-Z A Adwedl REB vqae R4
2 o A Al5d-Ye wdlugdl, AalFda-Y ol aalsd-X Wl aldfld 26§28 @ 20 o wEad
Rudld sHal vidg sl 2ad, el AlFi-ZA ugales (translator) ddly wdaviaml 2ud 8. dal
s MM vy oHL Q) Buid wiqdie (translation) s 2w S,

suuell oy Adl Anw wsaull w2l wrld [FRUSRRL Aiqeles (translator) Usteell Alg29R WA
gL ANl 2 B, W Mdles SWUSE (compiler) dild wWuuiadl wWad 8, el WUl
WL USWIAL vidil AMAqUHL wdel D,

WK 2 -l qwalBisdinl (Program and characteristics of program)

s Al A6 yd apena sl suadl w2 md widl Wasu 2wl [ABd Yzl yyea

WU 3l 2Ud B, wE S3¢ UL gRL B YANBA sHole Ad aviasdl WBUA DBl adld

wLAvaH] v0d B,

2 WA W (1A orudd dlaRisdid yuddl ddl Bl

1.  [FBd wial gl N zid 2ud d ¥39 8.

2. 03Ul wde Al sy epnyRd adl ASY), RNed 3 A Al ay el dradl «
Sldl ASA,

3. dwd YA BEsRs Odl ASW, Wed k d-d uMa Wy Hd wdl A,
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4. WM YU ¥ ay dye @ i
5. AU Ws koay wuGeye wwdl w

didl A R O 3, 2 dlaRsdal HARaHA diaRisdizial vodl 2d 8. Gelg@m 10.1 A
Ayrizy Al ous euld B Gewd@ 101 R ¢ R wd uReuy gl 10134 calon 8.
SciTE Rzl Guidi-l s ugl 2uud 20 wseel vidui ov{lg,

ASE 10_1.c-SdTE

File Edit Search View Tools Options Language Buffers Help

110_1.¢
/¥ Example 1: My first C program */ >gcc -pedantic -0s -std=c99 10 1.c-010_1
>Exit code: 0
Einclude <stdio.h> >.r’lﬂ_1
int main( ) Welcome to the world of C programming using Scite
-{ >Exit code: 0
printf("Welcome to the world of C programming using Scite \n"); |
return 0;
}

gl 10.1 :yan <D Wun

2l 303U g1l "Welcome to the world of C programming using Scite” 24 saldaiyi wad, il
main()? Guilaisdl gil RBd (user defined) [R8Y sdciil ¥d & R printf{ ) 2 2id WM
(inbuilt) ¥ aidaldl ARy 8. Guidusdl gl Al ¥3Ruld AR WAL sudal [AAYA Gudldsdl
MPd @AY (User Defined Funcion) $& ©. Guiotsdl Wil Wioussi Gudal sdl ad dar Al
el yddell Guasy (A3 AidRAUMd 3 cdsldl RAY a3 vl 2ud 8,

A suw RARY w28l Rgd wul 143 sdl udal susl 10240 sulda Waumed vew s
¥ uRsun wsl 1034l eale] B.

DO 10_2.c-ScTE

File Edit Search View Tools Options Language Buffers Help
110 2.

/* Example 2: Program to calculate Circumference of a circle */

#include <stdio.h>

#define Pl 3.14

int main()

4

float radius, circumference;
printf("\nEnter the value of radius: ");
scanf("%f", &radius);
circumference = 2 * Pl * radius;
printf("\nCircumference of circle with radius %f is %f \n \n", radius, circumference);
return 0;

} |

/* End of program */

susld 102 Gewm 1024 A3{aREa
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MA@  harshal@harshal-Compag-435-Notebook-PC: ~/Desktop/Chapter10

File Edit View Search Terminal Help
harshal@harshal-Compaq-435-Notebook-PC:~/Desktop/Chapter10$ ./a.out

Enter the value of radius: 2.5

Circumference of circle with radius 2.500000 is 15.700000

harshal@harshal-Compaq-435-Notebook-PC:~/Desktop/Chapter16s ||

2ugld 103 :GeRa 1027 wRwuw
uHYdl
wdl wld Wamd Gudal sdl wla Blowd 2wl ada-d wRe Dl wsy B,

o uud [ Adl 4 (comment) B, ¥ WAL GRwdl ML 2 .

o oflx At gl swdern "stdioh" Ul 4R s1ar{l [l A sl YusL wndl vudl
8. WAL Gudloil Qi 2udel Hid wafd QY Q-] wRd 21 sidadl wwiddl da 8.

e 1% Rt PI Al AidQs wa (Symbolic Constant)dl suuiRd 53 8, ¥ Bud 3.14 8.
2L Qi W-WNAU WS (pre-processor directive) dild Al wid 8, WUl Hue
sl uddl ul QA gL dd PT wsen 3.14 [Bad Wd sieadidl Yarl suyan 2ud 8,

o g At W Gualoisdl gl cuvRd RAY main() B, ¥ 4a 4 Uk ddl (executable) daud Wy
W2 50 B. wdl 21 QAU yals Avul vad sag dludl int main() @3N @viani v B,

e iwj A main( ) @Aa-l uzvud 8.

o ©§ [Qui radius ¥ circumference i+l & A avRd 83 S, 20 A8 wyals dvydd
A sl A B, A ouwt el YEl Batdl-dl AAS sl W2 uam B, Al erumi gel el
Gudldl 2AAS 50l HIZ2 AR WAl 28l Y4 (variable) dilk ol wid 8.

AW Qe ey owal HR2 printf @Al Gudlal 83 8.

25uL R Aid? R RAY scanf gkl Gudlatsal wdel B (radius) Aaqaiui 20d 8,
“qy [ As A s (C expression) B, A adu-l uRH AR W2 alsm B,
e Rt Bl (radius) A uRe(circumference)dl Badl wd 44 u uew euld 8.

BWRY QAu R wru-d oo (exit) Y3 Wl 8. 2 20 R auiddl «4 2d dl
Aqall-) A - "Function should return a value® eafacui »ud 8. Wt sdul A AS MR
g ], uig wwy affoud W gl Ws WA Aser B,

® ouv| (A4 main( ) @A) id culd B

Wyl 10.1 w1 10200 eulod Yoo main( ) [EA A Wunel dysl oudl siwRel 53 B, ayul
24 A sl WAN 3 wHa-Qey iy A Dunil Gudleisdl gl @wvRa A BN main( )
A @AY €ld o33l B, e3s Al Wnn »uelsel main( ) RAAAL Guger w1 s ({Hdl 13
S 2d B,
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A Wund e (Structure of C program)

U6 2wud AT o A ost AL Wkt 3 @AY AR dmeudl wElA aw S RAY W Wy
3 ay Qu-dA w8, B4l gl ydFulRa sdl-d g 530 wsiy 8. sugla 104340 2ysl 2
wisung, o) sulel 8. 2 [Repedl Brgd vl s,

| Documentation ‘

| Symbolic Constant Definition | | | Optional .
| File inctude section ‘ Section

| Global Variable Declaration ‘

— -

' ~
main()
Compulsory
{ .
Declaration 2 Section for all
executable
C programs
Executable Statements L
} -
Ve -
Function 1
User Defined
Function 2 < Functions ¢
| Function N | L )

2ugld 10.4 : Aysl A Wung W]
grrldevsael [Aeusl (Documentation section)
2L A5 WA RousL B, <un gl B A Yorer 2L [Reusi) GULlol ERAADSRI U2 S04 2UA B, A /* VA ¥/
+(l 42 20971 Quiai 209 B, 6 U @A /* 2 */ +{l 43 Buala duiami vddl auien A4’ (comment)
Hi-aul 204 B, A2 U Al sudaR gl S8 UBUL s viddl 4ol A1 dn -l du L8 saumi 20d B,
Wanaedl dg, Auis i, Wsud aviel dilv add Fdl uRdl ealaar 2 deu- A U Reudts
Gualal sarkii 3 8. A WML A wa wud S G wan 8. sinee GRdl B dAa
Bs WA 24 dRud B, SRE3 ddl G WNUHAL dluAHAL A AR A’ D,
ASQAs vandl envay (Symbolic constant definition)

Ble 102+ Gergreni eulel yorot WAL P Aledl AR vao-D Guildl s wiledl 8. W
2L WSRU AAS vAA-Al GUAdL s W2 A0l WL H#define GARG, %3 O. M, #defined -
WAAR USI[Ha (pre-processor directive) dd aviainl 2d S, & WUHHL 2ledl dxd ABRE
UM SuuaHi Al Bud A seadidl Jadl sudard yil ul 8. Avu- dd Ay vaa-
32 AR glRl a2 208 8. U 541l AR ALY Aet 52l wad) widl asiy B.

sife GAea [Aeust (File include section)

A eun BiduReRa 3 sl R YU ul 8. pow( ), sqrt( ) 43R el Gelga B, 2 RANA ydFBud
GRall & B, % &) pow( )l Gualol x +ll 210 ald Fedl Baud A W2 w0y S den 20ld wld wedl Bud

Al el uRay 195



DRl 2 wa B del 2udd v @y hal 22 sqrt( ) RAUAD GualdL s 2d 8. A ¥R Ty Al
AN WUHHL 2L QB GudaL 431 AL el 21 [QANAL Guadal el W2 drfl R 4adl §lSa
Wl GAL W B, Al eurusi 2 ot $15AA 342 §165¢ (header file) dR1d 2Davialni 20 B, 34 s1asd
irjeiot " h" dlu B, WoumHi AR §15a G W2 #include <filename h> clsd 3u-U-) QUL s34 U
8. ol cuniii Guasy s R s15arll ULl dul asi Gualal i) R WRRre TV i 2yal sl 8.
Ay ua Amau [@Qeun (Global variable declaration section)

Al elrunl Yar]l 214d Al RR (scope) WS seMl 2 B, Geddl i oid udl 99lRWL S () 4Rl
Al sl [ A8l sell 2ud 8. woRuL Sluml envulRd s3dl adA @RS 34 (local variable) dd13
vl wd B, ¥4 &, GelgW 10,241 Gualoini daui vuddl radius 29 circumference 44 main()
RAuUAL UMY A4 B, Bl WSIRAL AA-AL GuL Al R 6812 531 st A2l o B Aarl Gualal
il [QrciRell si1R usl drux [RANAL s2el $29dl ELSN dl, A Wil YA APus Yd (global variable) $8
8. Bl WHRU A, i, QA udal cpvuRa sl wd 8,

main (@82 {main function)

i ¥l sunml mainQ) -uneg RAY wagj‘]jm ®. 2w Rl Al Wand wells a3 sl
wd B, W Fuze e v QYA dsaai 31d 8 v @idl v Buaddl 2e s
2l B,

Gualasdl RRa Ry (User defined fumctions)

Al owm AS wal WA it Ropolai aduardl YA 4l uwd B, 2w QAowddd Rl &3
8. 2uven MauHHl @3 dal i wARsd RQAuA v Reusiml aruld Lami 2wd 8. sl
10.540 salden Gewdar 10340 Gualasdl g RBlA Al & QAN Gudlal sndrl 2wwel 8.

MO 10_3.c-ScTE

File Edit Search View Tools Options Language Buffers Help
110 _3.c

/* Example 3: Program to subtract two numbers */

#include <stdio.h>

/* Prototype statement of function sub */
int subtract{int, int);

int main ()
-{

int first, second, difference;
printf("\nEnter the value of first: ");
scanf("%d", &first);
printf("\nEnter the value of second: ");
scanf("%d", &second);
difference = subtract{first, second);
printf("\nThe value of %d - %d is %d \n \n", first, second, difference);
return;

}

/* End of main program */

/* Beginning of user defined functions other than main( ) */
int subtract{int first, int second)
-{
int result;
result = first - second;
return(result);

}

/* End of function subtract( ) {

aigld 105 : Gegm 1034 513 (RS
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angdl

L W3 2UAd A vl cnesitdl sl W2 GuAldll B, <l WU Al odl dd Gualosdl
gl Bl o QAudl Beulra saml 2uel 8. wan @AY main() eueoufl sal w2l & Budl
Al B wA ofly [AAY subtract) A cnesldll Bu vtk wR wl B,

il B A 261 B 3 subtract() QAU Guulal sadi udai d-ll wisla (prototype) 2% sl vudl &,
Gualotsdl gl RPld RAYA main() RAUL {2 auiaini e &y dl A elvni 2 %33 8. main() @AY
2181 Y&ils Ae DR 53 B 217, Aniel A el [Fd Gualoisdla 4@ B. cur usdl difference = subtract(first,
second) [l Guulal $3) i Bl subtract (AU 3AqLseall ¥0a 6, U first viv, second | subtract()
RAur WA (parameters) £8 8. vl Rt vinad] Yaunr FusieL subtract() QAU Hisaaini 2ud 8,
w1l A8y @2 uedl Budldl sieoisl 530 result el Aani wReHAL A 53 B, AR sie result dd{l BGud
main() [Q8u-iL Rt ud s 2ud & ¢4 difference =Udell YA d-l AAL s 20 B, Adul
main() A4 YRRUMA 2l wR culdl Waws Y 52 8. Gelgrel 10.37 WRRIA sl 10.64 sale B,

M ™ @ harshal@harshal-Compag-435-Notebook-PC: ~/Desktop/Chapter10

File Edit View Search Terminal Help
harshal@harshal-Compaq-435-Notebook-PC:~/Desktop/Chapter10$ ./a.out

Enter the value of first: 55
Enter the value of second: 24

The value of 55 - 24 is 31

harshal@harshal-Compaq-435-Notebook-PC:~/Desktop/Chapter10s [}

agld 106 : Gegaw 1034 wReun

A % suyfa 10430 euldg Al Waun o] dum NAHA g Guddil dal vuad waasd
wae] ol vugfa 10.130 salen Yool 3 wet sy B 3 il J2als QAo WUl Gudoi
Al - U dul keaws Rewol il vealsiedl vel s B, ¥u 3 A RRRA 10,140 euley B,
d yartt Guilatsal gl cuuPd RAU-L [Aoudd main() RA4-L Reuol A sedai 2usl 8. wdl
Gualatsdl gt FMBld RAYA main() RAu- udel Glrawni 3 8.

/* Example 4 : Program to subtract two numbers */
#include <stdio.h>

/* Beginning of user defined functions other than main({ ) */
int subtract(int first, int second)

{

int result;

result = first - second;
return{result);
}

/* End of function subtract( ) */

A suvurl ywRaa 197



ssfalEa 10.1 : 6w 10440 A3

& dgladil slle sl L NWH GelgW 10.37 A B, uAM dstdd A B ¥ subtract() RAuA
main() RAu-l udai awvRd KAl 2wy B A ol A 3 WA2du R GudloL s
sl «efl, Gelgwl 10.34i difference = subtract (first, second); [t gl Fxel wdld main()l
QA dg Wsdani vwd & WA GeldW 1044 R Nld main(l Gua-dl ds oy 8.

Al ouwdi YouaR (C Character set)

ddl e ¢ 3 2w U Wl AS Adl sl MEUA Sl Sl UL AMAH WNRA A-L
youad vl gdl. S5 URL GURAL HUUARL wselrll s{Rel Usug oid 8. Al el uR Wldi-i
youaldl oL (character set) B. ¥ YUuaAA AR Qo addl wsy:

1. & (Letters)

2. 68 (Digits)

3. adide ¥WA (White space)

4. ([Afre @&l (Special characters)
Bl ML vadl Youad sws 1014 salen

Letters Digits White spaces

AtoZ

atoz 0to9 Blank Space
Form feed
Horizontal tab
New line
Vertical tab
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Special Characters
Operator Use Operator Use
& Ampersand > Greater than
' Apostrophe # Hash sign
* Asterisk < Less than
@ At the rate - Minus
\ Backward slash () Parenthesis left / right
{} Braces left / right % Per cent
[1] Bracket left / right Period
A Caret + Plus
Colon ? Question mark
§ Comma " Quotation mark
$ Dollar : Semi colon
= Equal to ~ Tilde
! Exclamation _ Under score
/ Forward slash | Vertical bar

ses 101 : A euN-l Ymas)

sres 10.1 A sulen Hae 2wud A clmdl dzars waAAD GudsL sl B, vuell ¢d 2wud
W el Al ouwdll adusua-inl Guadlol sadi allvlly,

A asEl (C Words)

2res 10,1340 efdal youad-dl Guaol s Al eunini A6l el s2cuui 2d, B, vl Asel) Guaat 31
Al AU sitqaudi w0d B, 2, dilfs . sdolg avial 2dal Al R e 6 N add
Al vid 8, Al L 20del Astn s (token) $8 B, s1%es 10.130 AL Al g5 AR
YA s Aset B, Huod A Al cLNAL 9 WsRAL sl AUAH] 30 B : el WSARHIUR, 2,

a1, »iuier A RAre RAL Al sl 20 As-) Gualal 2ugR 10,740 saled B,

[* Program to illustrate use of integer arithmetic */

Keyword

#include <stdio.h>

o
7

ldentifier

L
/(@t)tot_cost qty =@.‘D}‘cost_item = 50;

clrser( ):

tot_cost = qtyEmt_item:N
printf¢”Cost of %d items is %d =gty tot_cost).

return;

@x

‘ Constant ‘

| Operator |

String ‘

| Special Character |

sugld 10.7 : A Wuuni el (tokem)d GuAloL

A cuwl uRay



FARTRS (Key word)

2yl AB 2035 dl acead Gudal el o B, F-A eumni vudal AS ydowuRd Wk vied kel W
B wsedlatd Gualol sAN 61, AL eUNL uR vual Yydewuufa 26 HAA B, AR A A ANSI
C wutlRe 32 ydeuyfia st i Wl B, Al ewmi wdar s ydeunuiRa aseln f-ad add
slaviami »ud B, 34 4-ad WA s YA ud sl B, ANST Cui Guasy 4l-adl wel aes
10241 sl wdl 8,

auto double int struct
break else long switch
case enum register typedef
char extern return union
const float short unsigned
continue for signed void
default goto sizeof volatile
do if static while

sn2s 102 : ANSI dl Alad
UOYIRASAAL 89 UeSlrl W4V 21U S-S 27 A Gualoll Q4 Al sennl v 8,
WSI2Hu  (Identifier)

Gualaisdl gl Al HousR) Gualsl s srudal vidd Ul WR(B61UR 58 V. A vaR), 3N
vir Z2dls AR RAF) W 53 usy B, difference”, "main()", "PI", "float” <93 aUSI2slu-l
Jedis Gele@ 8. 2l "difference” A4 U4 B, "main()* QAU 1A B, "PI" A 1A N B
¥ "float" ¥ YdauvalRd 10t S, ¢4, 2uAaq alal uddl ‘A’ 3§ B d R AA.

Y4 (Variable)

Al Wud W A Sqye dlsR 8, Sy ikl [gudl 2wd 8, -l AU A Gudlal
sl W2 ARl AL oouiel Gualol s el ARl 2wde 2L il R sl wadl wEuA
2 sieary B, Al wowml »ld 214 34 (variable) ddld doriidl g M gL FERA sl
Uud B, Wdil sled]l asciel Addl HR1adl 2 ud S8 B, Al el Adqd A wld s
Jedls Rl wan g o3l 8. 3 Awsd A eufen &:

1. Aad Ay faddl «4p 39 < &g ASA.

2. UGSl UL HJOUAR)Y, 215 A PRI Gualdl 53 wsd B, ey, LS Wl IseR
Wy, «efl,

3. Al AWMl NUH AR YOUAR HUdlL HRWR QU d w3l 8.
4,  ANSI 2R WHE Yael AUH-l Hean dois 31 2182 8, A 3, d $ULSaR UR wWURA B,
5. adl A AARIRA B, 124 & num, nuM, nUM, nUm 31 Num il d¥ld el gel
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Al ledls ML A M DH Aes 10340 salwi D

Yy,

Double - Double 3 4l-af doublen i =&l

INTEREST -> 3Rze ua Al yad- cusl 8,

total quantity = w61 A AR WY VD,

mark100 > BAH W& desoe Qe wy ],

file D A AU WRRER dE wsu B,

VY,
char > fl-addl Gudla, Hiw el

Total Value > wlel odL Wiwy «efl,

total&value > QR M4 3 <Al

10mark > RUAH WA ;ARRER § vileslo2 Ad.

shes 103 : Al wa-l Gogeal
Y (Constant)

WAL AHEl5RBL e ¥ v2sell Bua ogel asidl 2l A vam qaAF omanl wd . Ml
Ul 25l 10,740 eailed Yooy el el adllal adall wsiu B, v - Qg vl s,

Allus v (Numeric constant)

Hisdsly RO ARG sl RN WS van & O, WU vy O i Qeulsd A
wsy, : yals (integer) A ¥ yels (real) @awn

| Constant |
//
| Numeric [ Symb/c:Iic ] Back Slash ] [ Character ]
/\\\ /_/\\

\ P
Integer Real Slngle ] [ .
[ j [ [ Character String
/&\m /&%of\

Whole ,@®\
Number Number Numeric character Character characters
e.g. SOnsis constants Constants enclosed in
250, -99 . 99 9.58 represented ( g ( e.g. double /1
by name \ e ‘H,'8 guotese.g.

sl 107 : A wan

A e uRay 201



‘-j@li!l YN (Integer constant)

yais a0 224 cais Bia ad-Al Al (whole numbers). Y@lls w6l 211 Usiel & : eidl (decimal),
A4l (hexadecimal) 21 weisl (octal). €l Y€l vis-uglivi-i Gersel uRRIMe I3l wucidl vuai 8,

el vl 0 ¢l 9 iHH) Gudlol R 8. 3 Hhl udin Yl 4l (plus) 3 B (minus) [Fau-l
GAL sy B,

Al AN 0 fl 9 h A A Yl F 8-l Gualdl 42 8. 3dl A ol F aad viqsdl 104
15 vyl Fie 8 8. Wvidl Avul R 16 S, i Badldl Al slunl Guddl s
A AR A euidl Wwl uaEdl wigdl o AsAl R Ox w™dl 0X GRRA wd @,

seidl MU 0 ¢l 7 AL Gudlal &3 8. i vis-uglRidl 3R § B, L Buadldl ]l cuwsl
GuAlL S wd AR sS4l Avwel Med ikl d-l W 0 GRRAk WA B, es 104 Jedls
wey 2 e yals s euld 8.

HivY

40000 > w4 sQifl 4 yeils vy

—120 > Wy eaidl wa yals v

79999L > Wy eifl U o ayals v

0xB5 > W A6l Al

0X79 > =y AV vl

045 > Wy wwRifl Awyl

BLHLY

25,000 = weyQuu Wy «¢l.

-100.0 > d 2wyl wam ],

R579999 > &Rl Hi~y ¢l

0xG > G ANl isil 4 &S .

0X8,9 = uey[aus M-y -yl

096 > 9 uieifl Avul-l o3 43l 4 €l ud.

fnes 104 : ymis wam
2aypl wAN (Real constant)

wyals eudl wadl edidl 2is 2yel 20 a3 wdavud 8. 10.50, —65.75 A9 Ayl AL Gele@
8. 2yl el 2ild AaRs 2930 yat 53 A B. B wsR-l Vg2Ud W2 AR (mantissa) i
BsAnv2 (exponent)-l GUUlDL scuml vid B, Gelgal ddl¥, 25.75 dvuid ALy A@unl 0.2575¢2
wadl 0.2575E2 dd 2 3 wsid 8. wdl 0.2575 A AR A 24 Al 58 B, aull, "e" A
"E" vl B, Qes 10.541 J2¢ls Hird 3 ey, wyel vaudl wd wudl 8,

202 SRL2-BUA 10



HiY

250.00 > Wy caifl vyals

295 > Wy caifl Av BN 295.00 Hi i@ WHAL.

-15.55 © Wy wel swisl Avw

-20.5¢5 ° Wy s Bud

15E-2 > dix  dauMs Bad

BLHIY

19,800.00 -> eulEduyd i el
$786 > [Qle Ra W <),
9.4e5.0 > sl yals Qal Ad,

51E -2 > uiell ool Hi= «l.

fes 105 : wyd wan
VIAH UHRU YN (Character constant)

AN PHIDA AL HANHL VAU AU SR 2Ud B, AL cuNHL 6 UsIRAUL VE AN Guasy
B : By A WIL M 2 (AL A

s 2aR 93U AN (Single character constant)

VL USRAL VAL A5 WA W4 vadel P& (single quote) Hi 2wadld ¥ Rl 2«wd S, 'H, WV,
"7, '8 ABR As AR WL Y SN AL AN 2ais Gelsw B, ndl e35 AR WAL ASCIT
(American Standard Code for Information Interchange) <13 aeruildl Zad 01 2Addd &lu 8. ASCIT
Badl 249 A+l 0 2A3de el el valdl Radl wRAke I 4l suuaHi wudl 8,

[ﬁﬂl VYN (String constant)

2oL e & vadre Riel(double quotes)il wiadld @uiaidi ddl el AYS @I WY SN
314 8. "C Language", "Bye", "V" <33 [ man-i d2ais Geldwl 8. REol man wad 516 ASCH
Bud A9dell @il well. xdl, FFoL 2w "V" ul vaR 13U e qa VoAl «¢l. [Fa
"W 6 Rl AL 2 B, U VO BERA Wal Wy A=A siyakil sud 8,
5@ 3, Al el REol did 4 waR \O' el iy B,

oy W waRd (Back slash characters)

A weR Ring 2R A A5 el Gualdl 53 B 2wl [FFoL vAs A Gudldl K
8. Al ol s ey UsRAL AR wAM YAl U 8 ¥ 6 WARAA GuEldl 53 V. W wANA
85 @9 24 (back slash characters) 2idl W3y Ylsa-A (escape sequence) $8 €. NUH V&R
dia ols AL "\ Al SRR B NANA 61 WA WA dLF WDAAHL DU D dll Bl WYL
WReunazl gz @A cladl il 49 A ‘AR Alsaw’ ww 52 B, Ridg 3R vaaddl
9 wil ANl WA usl s ASCH Baud dstudel Qu . Al ol Guasy 6l da v
A At Gualdl dal ASCH Bl wel stes 10.640 2uvaimi 2udl 8.
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Back Slash Use ASCII Value

Character
0 a4 [Bud Glal e 0
\a gaely A3 Glal W2 7
\b o5l GAAL M2 8
\t 2udl 200 Gl W2 9
\n adl il GRaal w2 10
W Gl 200 Gl W2 11
\f sl gle G w2 12
\r Lor e G w2 13
\ 6 vade Ra Gl w2 k"
V Ns Aedwl Re GraL w2 39
\? wad Re GRa w2 &
\ os Aa GRRAL W2 2]

825 10.6 615 AU WA

By Rusarudl Gualdl yeud dlsael(formattingyit 8qR sl »id 8. Gewda ddld o' -
Gualol s Srye 3 wiBeye ¥ud Adl dldl GARl usy B, v A GUAL d YRS wAg
oA A usl

ABMAs van (Symbolic Constant)

s wA2suadl veeel vel wisOSY A AT AN AuUIRA 53 UL D, B UL
wund didls WA 58 B, UBRSs WA R s W2 A wRudd AsyRAUAL Gudla
Sl wd B :

#define identifier value

v, #definen Y1-WAA Q83ERA (pre-processor directive) dilk vilviani wud 8, ¥ wan ewvyiRq
Sl B de WK UH WRABHUR’ B - value A WU wAn B, AR nAanl deais Gerg@
13 cauldal -

#define PI 3.14

#define MAXVALUE 100

#define f float

il uuy QU P el ARs Aa ersRd 2 0 %+l Bad 2yals 3.14" B, olly R
"MAXVALUE" -l ¥idRs a0l crvyiRd 2 8 &l Bud yels 100 8 2 vk Qe
"ol RS wANA elid 2 8, ¥l Bua Al cuwsl wda fA-al “float" B,
WUHHL Gualail Al wdel dii AidRs A d- @il 2l Bad A seddrdl ya-
WA a8Ea A swdad i 8, s olas (Sphere)l AWl A=gn dual el Wun
Gergaet 10.541 ealodl B, ¥ WI-WRANR QERar) Gualsl S B, Gews 10,54 A R susk
10.840 ealef & dal 2wgla 109 Wouud wReun eald 8,
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MES & 10_5.c- ScITE

File Edit Search View Tools Options Language Buffers Help
110_5.c

{* Example 5: Program to find surface area of a sphere */

#include <stdio.h>

/* Definition of a symbolic constant */

int main{ )

-{ |
F radius, sarea;
P("\nEnter the value of radius: ");
S("%f", &radius);
sarea = 4 * Pl * radius * radius;
P{"\nSurface Area of sphere with radius %.2f is %.2f\n\n",radius,sq§ea);
return 0;

}

/* End of program */
2usld 108 : Gewkm 1054 A8 RREx

M ® harshal@harshal-Compag-435-Notebook-PC: ~/Desktop/Chapter10

File Edit View Search Terminal Help
harshal@harshal-Compaq-435-Notebook-PC:~/Desktop/Chapter10$ ./a.out

Enter the value of radius: 2.5

Surface Area of sphere with radius 2.50 is 78.50

harshal@harshal-Compaq-435-Notebook-PC:~/Desktop/Chapter10$ |}

2ugld 109 : G 1057 wReun

Al

vl WAL AR AdRs wan) wRa sul B ;P f-ad ‘foat’ w2, ‘P’ [RAY ‘printf 2,
‘S’ @AY ‘scanf W2 dal ‘PP wuyd Bud ‘3.14° W2, main() RAuqd wan QA F 2L usR w2
A %4 ewdPd 3 8. F W floatd MEu sig el w3ur wdl Q float Aad apvuld s
A B, 2l At Pl Guadl &30 A2 euld B, Awrugl S Gualal A Blorusll Bad aipami
wd A d\ds (Sphere)u AWl AxAsus{l AR sl A B, didHl &I Pl Gudla $3)
dee wd wwdl Aaga ealaqami Wl B,

A Waunnl We AvL Hel (Points to be remember in C program)

Al euwAi Mo A0 dlal odl, Al Hsad ¥3A V. ad A NAHAN AL [Benaiml wuyanl
A Yel Ue AU NN

o &R 51844 main() QRAu-l udal Gladl A,
o wud 3 wsy dar AS ua A UL €AW main() @AY S B,

Al euwil uRaa 205



o Al Wuausd wwuells main() uldl Gusdl esolRu Al ()l U3 sruHl wd B,
AL WAL A A vuadl & QAW ey Al
A {d, Al WBUAH el (small) VAR Rl d@vaami 2 8,
ASIRHUR AR B,
Al WAl 6 ol 4Rl Wl wedl Bgs vudl wowL ddl a3dl B,
i da Al orudi Rl w4R@An (semicolon) gL YR sRaAML wd 8.
il ooyl GAL wsy Qal dws @A -l (comment) G usy B,

e &5 Gasdl eolRw SR(HA Wild YR adl R4 H (}) dal a[ad 8.
2l silwu:,i U@ (Execution of C program)
iR YU 2R el ) B0 A del wRBUA A4l gd MR A WAL Wi sl kW,
YA 2ol Sl Ual L 412 %3d] Aal i AN, 2R 10.9(@)HE 2 ARl WBUL suldl S,

User Types program in

\

Editor

Source Code

Translator

Object Code

LibraryFiles
Linker

Executable Code

Data

Loader

Final Output

suyld 109 (2) : A Wauwnnl swmdlsRni waal

»us0A 10.9(a) i eulen yorsy, 2522 AR Gualal 431 Wgun @mdl 3 A wan W B. 252 AR2R-L
Heedl quaHi wudd WA ARl 8 (source code) meal WAL WM (source program) 8 8. Al
sl @uiail wad ¥l sidad viqeeid "o B, R ugl sudar-dll neeel WluA Asld (compile)
sl WA B, Susay N Ws uales (translator) B, ¥ A WunA 2ledse A8 (object code) ¥
w652 WM (object program) <l 2uiidl Helld el A0 3uldRd 43 8. ulsyse S gei
el UL Guact 8. R ugl RisR (linker) <UL il Wl needl viegyse ¢ A alddlzl
§16ar A3 (linking) 53| W\E3sy20ia 13N (executable program) & WEnsy2ee 518 (executable code)
AR SRaHl 2 B, viddl, WReuH saladl W2 2 AFsyRed AR %37 doldl WA 8k (loader)
wlatsil sl Heeel AxTL ysauni wud B,
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U Yool 2R gee WAL Sudar-l Gualal il 8. gee 4wddl Free Software Foundation gl2l Y3,
wsal e 8. d YRy [ Qs 20HRd ANST Al sudar 8. uiurd Ad Al suss s gl
Gualoiui Aanyl 203 B, Ui A SciTE Fal 252 AR22 Ml Eclipse ¥l $[2324 Jaguie draiyilee
(Integrated Development Environment - IDE) 18, Uy Aisvll asid 8. {21601l dsud RiAsu-nau-dl
Al A ydeuld iy B, Fl WD A Gualal AS o Yadell qdlr Ul 530 A4 A,

), YD SHUSaRA Gualal 536, Al nam 252 AR Gudlal 5 W avandfl ¥R wid. Al
W Quicl W2 S U 2522 AR2e+L Gualat 531 usiy. Risu 2B Rt vi, gedit, emacs 219
oflon geu 2522 MR Guas B, ausl virst y dg 1S As 2522 R urle S, WsHIA did il AH]
vl AN 3 srudaril 2uddl gifarl o vieor vl W LA ¥R 8. AR ‘¢’ -l (small)
AR @ride i d wa 3L 8. el A W3-l AL 501 W2 gedit el 25 WR2RAL Guylal
s, 2Bine v, -l W YR gedit myprogram.c 2184 52, w0 selell wusla 10,1040 gl yorvis]
B4 viiel AR2R vadl.

Y ¥

myprogram.c (~/Desktop/Chapter10) - gedit

File Edit View Search Tools Documents Help

!- ’ Open ﬂ Save |;| €~ Undo

myprogram.c ¥

C v TabWidth: 8 ~ Ln1, Col 1 INS
sl 10.10 : vuel AR22

WL siel AR WUl ¢d £ ARSI 10240 2uvadi wwda [@Qsidl GARL

/* Example 6 : My C program */

#include <stdio.h>
int main()
{
printf{"\nWelcome to the world of C programming using gec\n™);
return 0;

a3 [AR3 102 : Gagw 1061 £

Wi ddR 4 aw ussl AR wugld 101140 ealod yon Bl sife-l A 430 AR2R oy
£,

A euwwdl wRBau 207



£ A o~

myprogram.c (~/Desktop/Chapter10) - gedit

File Edit View Search Tools Documents Help

._ .- Open - ﬂ Save ;. &= Undo

myprogram.c ¥
/* Example 6: My C program */

ffinclude <stdio.h>
int main()

printf("\nWelcome to the world of C programming using gcc\n");
return 0;

)
C » Tabwidth: 8 ~ Ln8, Col 2 INS

gl 10.11 : GeR@ 1061 &3 [AREa wA A2
€d U dq swddud Rdl dur gl 2fl-anl wusl & DA wsudd sus aduw s :

$ gcc myprogram.c

ol WAHHL AS L Al U dl dal Wl i) sulaid. wu-l 218 A 3 suddun-l Ba usoayds
Yl 4 8 wd AR @dadl A Rl vied 8 A o RNl aout yd FulRd «wn wd
As AR slfarl - sl wudl 8. A Dl ARl ¢d A A saladl A2y L W
velld seani 2wad, Wonnul alRl §u dl dl g2 &3 WA Yo swde sad) o3dl 8. Dt
uReun adar w2 «fld amudd sus adu 53 w2 4 esidl:

$ Jaout

W U gL myprogram.e WAL WRRUA gl 101240 eulen yadt Y sl wWad :

M & harshal@harshal-Compaq-435-Notebook-PC: ~/Desktop/Chapter10

File Edit View Search Terminal Help
harshal@harshal-Compaq-435-Notebook-PC:~/Desktop/Chapter16S gedit myprogram.c

harshal@harshal-Compaq-435-Notebook-PC:~/Desktop/Chapter16S gcc myprogram.c
harshal@harshal-Compag-435-Notebook-PC:~/Desktop/Chapter16$ . /fa.out

Welcome to the world of C programming using gcc
harshal@harshal-Compaq-435-Notebook-PC:~/Desktop/Chap

vugld 1012 : Gagw 10.64 wWReun
a3l DA HUddad aout Al YdRuRd siSardl @ sg dlal odl, wWRewl sidasd
A NG AW ay W 2q deuy B, W Rl wWild A WA URew{l sdd AR s
udl oui Yl Yo Akl gl 4 wu @l Y AN wAs AR yaGuda uw s wau B,
A amudd s wRAM §154 v wag A eald S
$ gcc -0 myprogram.o myprogram.c
W sl wud e myprogram.o WReLM s1Sa U 2y L3 B. ud ol WA A
slfad A eald B, uun wWofde W o ol Guddl Rl dwel B d Rl W Wt
Ria & 3 2wde sifa wReudl (output) $1Sd B, WA AW uqdsndl %3] Aell, W2
myprogram.o-il - Mol myprogram M@ avl wsm B, wWla Mouuddl Asndyds wHa ud
dl suda ¢d aoutd 6led myprogram.o el HSa siudd, ¢d AN {lAA sl AHA
s90 g wRsun Aadl wdy

$ /myprogram.o
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gee &S WA ey meu wAd-l Guadla va s3I asd 8, gee sus Q- [BAgd uee Anqal
W2 A oeuda sesedl Guulal s3 amu B
$ man gcc
S 2R 2=y g WAL av(lal sude sl Uuet s3.
Gelga@ 10,741 eafda W vidurald AU Guadla 53 Guasisalal wla v aslya 2Rl
AU B. sigld 10340 20 GeldRrig, S8 RIRRAL wuM 2 8.

A S M 10_7.c (~/Desktop/Chapter10) - gedit

File Edit View Search Tools Documents Help

!, B open - B save & & Undo

10 7.c %
/* Example 7: Program to calculate the square root of a given number */

#include <stdio.h=>
#include <math.h>

int main( )

{
double number, result;
printf("\nEnter the value of number: ");
scanf("%1f", &number);
result = sgrt(number);
printf("\nThe square root of %1f is %Llf\n\n"
return 0;

number, result);

1

3
/* End of program */| N

C v Tabwidth: 8 ~ Ln 14, Col 21 INS

sugld 1013 : Gawgm 1074 A8 (AREa

geerll Gualol 531 20 WuHA sudd seel wuet sAA. 2Bind vl sus e R A 2l
SIS 28U s

$ geec -0 10 7.0 10 _7.c
W gee suweed uRRUAN 2gfa 10.14%0 ealo) B

M ® & harshal@harshal-Compag-435-Notebook-PC: ~/Desktop/Chapter10

File Edit View Search Terminal Help
harshal@harshal-Compaq-435-Notebook-PC:~/Desktop/Chapter1@$ gcc -0 10_7.0 10 _7.c

/tmpfcccPZfEn.o: In function "main':

10_7.c:(.text+0x4d): undefined reference to ‘sqrt'

collect2: 1d returned 1 exit status
harshal@harshal-Compaqg-435-Notebook-PC:~/Desktop/Chapter10$ |

2ugld 1014 : Gegw 1074 wReun

wd[ A ouolddl A s %, uRgusai sdme-l @A "undefined reference to 'sqrt™ AW eeldadiui
2uell B, WUHHL sqrt() WAL 2R QAU Ul il Qaiell suddad A Al wd
aulfas adadl Al 3 8. A xhd su~ g2 Uiy asdd Ad and.

$ gee -0 10 7.0 10 7.¢ -Im

2 S didaE] A A uRL sl dtd PR sudd 4 wd. ¢d e WR /10 7.0 adu
s9 uReua gl wsl 101540 w3y uReun sule B



&S @ harshal@harshal-Compaqg-435-Notebook-PC: ~/Desktop/Chapter10

File Edit View Search Terminal Help

harshal@harshal-Compaq-435-Notebook-PC:~/Desktop/Chapter10$ gcc -o 10_7.0 18_7.c -1lm
harshal@harshal-Compag-435-Notebook-PC:~/Desktop/Chapter16s ./10_7.o0

Enter the value of number: 25

The square root of 25.000000 is 5.000000

harshal@harshal-Compaq-435-Notebook-PC:~/Desktop/Chapter10s [

wugld 10.15 : Gaga 10.74 wy uRwun

2l culdedl gl Riasu 2vIRA Riexadl Al DU dmal x4 sudd s we-dl Ael wagw
gl 8. vy 46 uRL Ael 252 AR GUElAL S o1ed W Yadsdi WM A Avial v
Wiud Al U2 SciTE «wnidl 25% 3Rzl Gualal 433, SciTE 2 o [l Waund suda
A ua sl yAm yfl ud B, Gudosdl wddl $-ye Aadarl du A wsiee Wud SciTEx
avll asu B, uig ddl HA KA w2 W 2Midadl Gua s

IR 521 oY, W WYl SciTE 252 3IR22 uldl wyel 2061 GeldQl SciTE wR2R
R-AA 2eia AN 8. sl 10130 edlon Hww SciTE AR viell il Gewge 10,131
»0d dulel a8y s sdad 10 1o U 2wl AASE R W w2 Cirl + S uwal

File - Saverl Gudal s3 and. ¢d QA-Q gl 101640 culon Hooin Buia ¥ @l

DS G 10 _1.c- SciTE

File Edit Search View Tools Options Language Buffers Help
110_1.c

/* Example 1: My first C program */

#include <stdio.h:=
int main( )
=g
printf("Welcome to the world of C programming using Scite \n");
return O;
l}

swyld 10,16 : SciTE R-dmi avla Geawre 10.1
Bgalz WUH avits oy el A 4 anu gl dul B AS asuadidl 6@ (syntax errors) 2uddl
QY dl d dhadl 3R wdl. B @ Aual W2 WA Hudd se)l ud. B W Cirl + F7 4
»ual Tools > Compile (Aseq wde s A WAL AS Al ¢l du A gl 101740 eulon
yoroiell Al Y s wuad.

©e® 10_1.c-SdTE

File Edit Search View Tools Options Language Buffers Help

110_1.c
f* Example 1: My first C program */ >gcc -pedantic -Os -c 10_1.c -0 10_1.0 -std=c99
>Exit code: 0
#include <stdio.h> |
int main{( )
=

printf{"Welcome to the world of C programming using Scite \n");
return 0;

}
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dd NUAHAL xHe 531 Asd. i W2 F5 4l sondl wadl Tools > Go [Rsey e s 2 sl
Wl 10,1841 salen Yoot DN Al wd b2y A caldani 2uad.

@S ™ 10_1.c- ScTE

Filte Edit Search View Tools Options Language Buffers Help

110_1.c

{* Example 1: My first C program */ >gcc -pedantic -0s -¢ 10_1.c -0 10_l1.0 -std=c99
>Exit code: 0
zinclude <stdio.h> >gcc -pedantic -0s -std=c9910_1.c-010_1
int main( ) >Exit code: 0
i >.f10 1
Welcome to the world of C programming using Scite

rintf("Welcome to the world of C programming using Scite \n"); ;
P ( prog 9 9 ) >Exit code: 0

return 0;

sl 1018 : & A~ wdy SdTE AR2x

2l 3 AS ws B § wwud el ol ugRivdd uRewn eulawdi 20d B, 2wl D suda
Ral el ¢ AR 1A Wl wRam wan sulaani el o :

> gee -pedantic -Os 10 _1.c -0 10_l.o —std=c99

> Exit code: 0

gl uRBeum a3l Hddl 10 1o $154 e 498 a3 A skl Al SR Go-ll GUUloL KA
wad i A weude wlReun Aadl wdy:

>gee —pedantic —Os —std=c99 10 1.c —o 101
>Exit code : 0

>./10_1

Welcome to the world of C programming using Scite
>Exit code : 0

wdl s15a U O asssidl WBA SRnl 2d B, nad ddssidl siddn Sudd KRl WA 8 A
10 1 <l Ensy2oe s16d ouqadl 2ud 8. 20 WEAL wan 8 A gl g skl wudl
8. ol asissil (e el ealon yaor) /10 1 susdl Guadal 531 2uGye s1fadl wHa sami
wal) 8. el A 1A wReun suld .

A4 0 > R whl wWadd avue A swsaR gl sRami wAdl wBa 8, xud Gudasal w2
4 w2 salaql yReuadl wan > Rl 6Rami dnadl <l

F8 4 etudlq »ual dl View > Output Rseu Guilol s34 2u62y2 A< suladl & ue seladl
Rl sy B, HAUGHL i YRR €R s Shift + F5 4l 2adl Tools = Clear Output [RAseu)
Guala s9) usy B,

21l GelRldl 2uydl Ad) N3 wale 36l ¥ oY Ald sl sA 43, w2 Luddunl uBu el A5
ol 22 sulacqiil sued 44l ¢d WA 3 ASH 3 A w02 Wk GARAML A dl g w7 WA 3,
2Rzl wud Gelea 10.2 A3l 32812 WA GAY B, “circumference =2 * PI * radius;" Rt duiad
oed 2wl 28MioL ejd 3 "circumfernce = 2 * PI * radius;" avy 8. ¢d % vl Cirl + F7 wadl

F5 4 eoudl ol 2usl 10,1940 eafen Horor-ll 2614 297 sl iadl,

M@ ® 10 2.c- ScTE

File Edit Search View Tools Options Language Buffers Help
110 2.c

>gcc -pedantic -Os -std=c99 10_2.c -0 10_2

10 _2.c¢: In function ‘main’:

10_2.c:10:6: error: ‘circumfernce’ undeclared (first use in this function)

10_2.¢:10:6: note: each undeclared identifier is reported only once for each function it appears in

10_2.c:9:11: warning: ignoring return value of 'scanf’, declared with attribute warn_unused_result [-Wunused-resuit)
>Exit code: 1

wigld 10.19 : @ WRadl WA srwddun

Al sl uRuy 211



dyel oL Qoy d saldl asd A A deuell Al el 2u6eye A o safaqiml 2udl @, st wReum
al W2 Option -> Vertical Split Rseu wie 531 s B. 2usl 10.1941 &4l (errors) suldel AS
sy 8. suglasl wNel "10_2.c:10:6: error: 'circumfernce’ undeclared (first use in this function)"
ldl il d euld B ¥ circumfernce i) Ad WLl @B sl el el ¥l opa Yl 53
WA S sl UBWAL wHa 2. €d, F5 4 eoiail udl sudar A8 ald «dl 44 dl d
WAL A1HA, 5 QU 58 % 3, 2N WAl scanfl) QA Gudla sl @euell w0 Bl
A6 wReun euldami 2al Adl Goprg-ll dlani Guioiil Al 2uddl SCiTE-L 2ugfaHi &l (bug)
dlaie weud 8, 5128 & d Gualotsdl widell $qye w2l A Ag el LS iefdoid AR 1S Ar
GualoL 53] 2uusl 2flva gL WusH) 2Ma 530 Wil e,

Al sl SlAgi (History of ©)

Al Daud R vew saf sig, ¢d Al RGN A Al AR Audl, Al sy ya S, A,
197241 e dsDR2l (Bell laboratory)Hi vl wdl. Al eumil v Ay JFA A4, R (Dennis M.
Ritchie) 20l 4514, Basic Combined Programming Language (BCPL) U} vl aury wefl Al
auefl 2l sl Bl ddll. AL eunidl 2l 8¢ B Y (robust) [Fikew Algzdr sidldadl gdl.
uig ugdlell aniHl A UL B el o1l 81 B ddH RsiReL Al§292 etsiidal W2 dxdl Guylol ey
@), H12 % A General Purpose Programming Language o3l sl i,

§. A, 197241 Aldd 2L eumA 198941 American National Standard Institute (ANSI) HRUHR8L gIRL
wReyd st wdl. AR Ul da well { (ANSI C) a3 sdasarii wudl. 2y 20 wadien
el el ABoL Ried uid swday g widd it 2wl B,

Al s AR (structured) el B, Al WsudA QAU AN Wil Al Qewdls adaadl YRw
8. sk U [A-] U sul one Al Y GudaL Asy B i QABuAL Wy A WAL
8. 2wl A aldd Mara R4 U Al 20 WRPHL gL A3 WBUHEA oied HA 21y (R34
Gu tud ARd s31 asu B, wuey Ad Al enwdnl avianl vuddl A8 wa Wun dARad 81
wd vy WUIRA Rred ¥ sudar YAddl el el vl wr dodell wdidl asy 8, s 3@
Al eund WEsa (portable) oirid 8. Jedls Al euwA (e dqa ddd% (middle level language)
WA B dl Jeals W2 A GluR Aadq 2% (higher level language) 8. s WM 3L A
A JRUL S8 4 wn A clwsdl Gualsel Guesy 8,

AR

L used wuel Al NBuuHl sitRel QA vewa sl A WAL Aot 3L Guddl d4f
widl ARY 224 AL Masl Audl, wr ugl 2wudl A euMel HousRl R we sewn s,
¥ waR), s, ide WA wd QARre R W Y Rowsnl aduidal B, 2R B HoUARlsl
Guallal s Al el wseldll AL sl dlvdl, cisie vl AL Wl AL WA sxdlswtel
Wil AUl N3UHA SuSd dul e 59l M2 gee sUdeRAl Gualal sl siadl gl Al W
dudl A Al xHd sAL SciTE 252 ARl Gualor sl allvay,

Rad ya-

SciTE 252 Rzl 2l »idl 23 welld s2al wudl & ¥ a1 AR vl YRR & 214
arll alids2 Guesd 8. SciTE RR2ML Al WU aviald U3 sdl wdal A Flua s g w37l
8 3 aul ol WY Asa2 Language > C/CH Rseudl waiesll s3el i, sum sadl auad
Al Wanm avidl auid f-add wsiBid (highlight) $3 salaqmi 2wd S,

L GURid F5 ¥ Tools > Go [Asey-l Gudlaell SciTE 3l A A1) o W3uusdl 24 suadl $69dl
QA dl WuRy sl 0 aeuda i Gl w3 o-a

command.go.needs.*.c=gcc $(ccopts) —std=c99 $(FileNameExt) —o S$(FileName)

1 ealda woal g W sifa sedl asd -
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6.

dHIA 2421 cpp.properties sl e Ml 181 (¥ 529231 A /usr/share scite/
cpp.properties &.)

2Bine vl Al sudo edit your file path/cpp.properties 216W 43 A2y 4l eond),
il AP waal ymai wual.

gedit =3l cpp.properties 15e wad. dres 10.740 eulon sl A8 sdanl W
AR

ccopts—pedantic -Os
cc=g++ $(ccopts) -¢ $(FileNameExt) -o $(FileName).o
cce=gee $(ccopts) -¢ $(FileNameExt) -o $(FileName).o

make.command=make
command.compile.*.c=$(ccc) -std=c99
command.build.*.c=${make.command)
command.build.*.h=§(make.command)
#command.go.*.c=./a.out

command.go.*.c=/$(FileName)

5r2s 10,7 : cpp.propertiesHi WAl £

dRl sl Beedl 8 ldl v o wuddl 8 Al vuddl R A d €l U dl A
sres 10740 euloll yors @uil, 20 s Al e 8§ Ful SciTEAL Gudsl sdl
auid NERRRKa (2u82y2) sidad A WA #dal Al Gudlol s i 2uad,

wl gSail QR 2l Gl s1Sadl Aus s :

# To make the Go command both compile (if needed) and execute, use this setting :
command.go.needs.*.c=gcc $(ccopts) -std=c99 $(FileNameExt) -o $(FileName)
gedit ¥ 2BiMd [A-) o1 sA. SciTE AR2R ¢d Aur B,

il WSV MNAHL 20l Wl AN RN Wl B, Wl Gueasy Goppl BigR Yol A vadl
A8 a¥ B, uig Wl sl Asuwsuq o W B,

;s o b W N e

Y

A Wsuadl aaBsal wel steudl ungdl sl

main( ) [QRu- u¢d AuAdl

A Wsunnl ‘glda Sy’ Ronadl dq o 8 ?
wSIRg1uR ved ¢ 7 Al Wil A 3l A Guall B ?
dd dl2d ¢ ? Y9 evRd KAl [yl wridl

Ws MeR Wl FFol wAN qAA) dslad weudl

Al suwel uRuy 213



7.

fA Qe wal 8 3 vlel d wsudl:
(@ WU "h" uveoi viuami wd ],
® W Ad Al QA vedRanel Yri nRam 2w B,
(c) Amount ¥ Aya~| Uy U B,
(d) #define PI 3.24 gt Al WML PI Al s16e GlRami wiadl.
(&) "X" A W& vaRq dou Gewra B,
wld [Aseduid]l Wil QAser wie s :
(1) 1 un sdan DA-uniell 53 uqdod wwvnamli wd S ?
(@) c ®) h (c) s @t
(2) A yadd eal Reudni adflsa A asm ?
(@ 0 (b) 2 ) 4 @ 8
(3) =" Rad A g s qodui wulwe S ?
(2) ¢4 (b) vuell oo
) QR R (d) »is
(4) A euwai (A-uniel sl uoe doy fal §°?
(a) ofsize (b) sizeof (c) forsize (d) sizefor
(5) Al sum W2 fAunidl s g wHY B 7
(a) Register (b) Reglster (c) registre (@ register
(6) ol ouwt W2 QA-nniefl £ yel van wdoy B ?
(a) OxG (b) OxA (c) OxB (d) OxD
(7) Al oumy w2 QA-uniell 2 2yel wAR Yoy S ?
() —2.0.5e5 (b) —20.5e5.5 (c) —20.5¢5 (d) —20.5¢.5
(8) fl ot w2 NA-uniefl s AN Vs vgR WY K2 B ?
(a) 'a' (b) \a' (c) "a" (d) a ¥ b tin
(9) l sunl A-uaiel] g 2R s 02 #define MNAAR QSERAAL Gualol s3] wsy ?
(@) o 2 (b) AR v
(c) Yol wam (d) As BaAR
(10) DAxil 5§ £ @ W3uxAD) A8 ¥ 2He A ww ?
(a) F7 () F9 (c) F5 (d) F8

SP2-HRUA : 10



wadBis kutay

1. dg e, o Ay, DR0 B woneg de) -l anl edlaar wHAl Al W s,

a0 o e sje e sl e i s ol aje e afe e ol e o nfe o ol e o e

* Name : *
* School Name : *
* Standard : *
* Address : *
L »

kR kkEekkkpkkkkEekk

2. Wl Y Rl viesdl wad e sdlaar wedl Al WuM eisldl Gewsel diZ AW dausdl
p2sdl NUH WA Py d 1A yaor uReuw eafad AL

e e dje g
* *
* *
FhEkENE
*

*»

*
3. dwdl udedlldl QAlust Az Al U eulaql HERA A WM @ul. Gedr@ afld, A di

A6 Reanwoll v yAAsL wsadl S5l €L dl "Wishing you a Happy and Prosperous Diwali"
Wwu euldl
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